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PC*MILER®|Rail 
END-USER LICENSE AGREEMENT 

1. Grant of License:  Subject to the terms, conditions, use limitations and payment of 
fees as set forth herein, ALK Technologies, Inc. ("ALK") grants the end-user ("you") a 
non-assignable, non-transferable, non-exclusive license to install and use the 
PC*MILER|Rail solution(s) you have purchased ("PC*MILER|Rail") on a single 
personal computer. The PC*MILER|Rail software, data and documentation are provided 
for your personal, internal use only and not for resale. They are protected by copyright 
held by ALK and its licensors and are subject to the following terms and conditions 
which are agreed to by you, on the one hand, and ALK and its licensors (including their 
licensors and suppliers) on the other hand. 
 
2. Title:  You acknowledge that the PC*MILER|Rail computer programs, data, concepts, 
graphics, documentation, manuals and other material owned by, developed by or 
licensed to ALK, including but not limited to program output (together, “program 
materials”), are the exclusive property of ALK or its licensors. You do not secure title to 
any PC*MILER|Rail program materials by virtue of this license. 
 
3. Copies:  You may make one (1) copy of the PC*MILER|Rail program materials, 
provided you retain such copy in your possession and use it solely for backup purposes.  
You agree to reproduce the copyright and other proprietary rights notices of ALK and its 
licensors on such a copy. Otherwise, you agree not to copy, reverse engineer, 
interrogate, or decode any PC*MILER|Rail program materials or attempt to defeat 
protection provided by ALK for preventing unauthorized copying or use of 
PC*MILER|Rail or to derive any source code or algorithms therefrom.  You 
acknowledge that unauthorized use or reproduction of copies of any program materials 
or unauthorized transfer of any copy of the program materials is a serious crime and is 
grounds for suit for damages, injunctive relief and attorneys' fees. 
 
4. Limitations on Transfer: This license is granted to you by ALK. You may not directly 
or indirectly lease, sublicense, sell, disseminate, or otherwise transfer PC*MILER|Rail 
or any PC*MILER|Rail program materials to third parties, or offer information services 
to third parties utilizing the PC*MILER|Rail program materials without ALK's prior 
written consent.  To comply with this limitation, you must uninstall and deactivate 
PC*MILER|Rail from your computer prior to selling or transferring that computer to a 
third party. 
 
5. Limitations on Network Access: You may not allow end-users or software 
applications on other computers or devices to directly or indirectly access this copy of 
PC*MILER|Rail via any type of computer or communications network (including but 
not limited to local area networks, wide area networks, intranets, extranets, the internet, 
virtual private networks, Wi-Fi, Bluetooth, and cellular and satellite communications 
systems), using middleware (including but not limited to Citrix MetaFrame and 
Microsoft Terminal Server) or otherwise (including but not limited to access through 
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PC*MILER|Rail interface products), or install or use PC*MILER|Rail on a network file 
server, without first notifying ALK, executing a written supplemental license agreement, 
and paying the license fee that corresponds to the number and types of uses to which 
access is to be allowed. 
 
6. Limitations on Data Extraction:  You may manually extract data (including but not 
limited to program output such as distances, maps, and reports) from PC*MILER|Rail 
and use it in other applications on the same computer on which PC*MILER|Rail is 
legally licensed and installed, as permitted below.  You may not transfer data extracted 
from PC*MILER|Rail onto any other computer or device unless you have licensed 
PC*MILER|Rail for that computer or device.  You agree that you will not, nor will you 
permit your trade partners or anyone else to, use content derived from PC*MILER|Rail, 
including route line data, nor display such data or integrate such data into another 
provider’s service, including, but not limited to, Google or Bing.  You agree not to pre-
fetch, retrieve, cache, index, or store any data, content, or other portion of the product 
output at any time, provided, however, that you may temporarily store (for less than 
thirty (30) days) limited amounts of such content for the sole and exclusive purpose of 
enhancing the performance of your implementation due to network latency, and only if 
you do so securely and in a manner that: (a) does not permit use of the content outside of 
the scope of this Agreement; (b) does not manipulate or aggregate any content or portion 
thereof; (c) does not prevent ALK from accurately tracking usage; and (d) does not 
modify attribution of the product in any way. 
 
7. Limitations on Mobile Communications: Without limiting the generality of the 
foregoing, you may not transmit PC*MILER|Rail street-level driving directions through 
mobile communications systems such as satellite, cellular services, electronic recording 
devices, or to mobile devices such as computers, telematics systems, on board or mobile 
computers or Smartphones, handhelds, pagers, electronic recording devices or 
telephones without first executing a written supplemental license agreement with ALK 
and paying the license fee that corresponds to the number and types of devices and 
systems to and through which transmission is to be permitted. You may not use this 
License, any of the Licensed Product, or its reports, to create a competitive product, 
solution or visualization platform. 
 
8. Limitations on Disclosure: You may disclose PC*MILER|Rail distances to trading 
partners, in the course of their providing services to you, for specific origin-destination 
moves for which you provide transportation services and use PC*MILER|Rail distances 
as a basis for payment.  You may not make any other disclosure of PC*MILER|Rail 
programs and materials, including, but not limited to, program output, to anyone outside 
the legal entity that paid for and holds this license, without prior written permission of 
ALK. You acknowledge that the PC*MILER|Rail programs and materials, developed by 
or licensed to ALK are very valuable to ALK and its licensors, and their use or 
disclosure to third parties, except as permitted by this license or by a written 
supplemental license agreement with ALK, is strictly prohibited. 
 
9. Security: You agree to take reasonable and prudent steps to safeguard the security of 
the PC*MILER|Rail program materials and to notify ALK immediately if you become 
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aware of the theft or unauthorized possession, use, transfer or sale of the 
PC*MILER|Rail program materials licensed to you by ALK. 
 
10. Acceptance:  You are deemed to have accepted the PC*MILER|Rail program 
materials upon receipt. 
 
11. Warranties:  ALK represents and warrants that: 
  

a) For ninety (90) days from date of purchase, PC*MILER|Rail, when delivered and 
properly installed, will function substantially according to its specifications on a 
computer purchased independently by you. 
 
b) For ninety (90) days from date of purchase, the software media on which ALK 
provides PC*MILER|Rail to you will function substantially free of errors and 
defects. ALK will replace defective media during the warranty period at no charge to 
you unless the defect is the result of accident, abuse, or misapplication of the 
product.  
 
c) THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER 
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITING 
THE GENERALITY OF THE FOREGOING ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE. THE 
PC*MILER|Rail PROGRAM, DATA AND DOCUMENTATION IS SOLD "AS 
IS". IN NO EVENT SHALL ALK OR ITS LICENSORS BE LIABLE FOR ANY 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES SUCH AS, BUT NOT 
LIMITED TO, LOSS IN CONNECTION WITH OR ARISING OUT OF THE 
EXISTENCE OF THE FURNISHING, FUNCTIONING OR USE OF ANY ITEM 
OF SOFTWARE, DATA OR SERVICES PROVIDED FOR IN THIS 
AGREEMENT. IN NO EVENT SHALL DAMAGES TO WHICH ALK MAY BE 
SUBJECT UNDER THIS AGREEMENT EXCEED THE CONTRACT PRICE. 
THIS WARRANTY SHALL NOT ACCRUE TO THE BENEFIT OF THIRD 
PARTIES OR ASSIGNEES. 

 
12. Disclaimer: The data may contain inaccurate, incomplete or untimely information 
due to the passage of time, changing circumstances, sources used and the nature of 
collecting comprehensive geographic data, any of which may lead to incorrect results. 
PC*MILER|Rail’s suggested routings and distances data are provided without a 
warranty of any kind. The user assumes full responsibility for any delay, expense, loss 
or damage that may occur as a result of their use. The user shall have no recourse 
against Canada, whether by way of any suit or action, for any loss, liability, damage or 
cost that may occur at any time, by reason of possession or use of Natural Resources 
Canada data. 
 
This data is provided to you “as is,” and you agree to use it at your own risk. ALK and 
its licensors (and their licensors and suppliers) make no guarantees, representations or 
warranties of any kind, express or implied, arising by law or otherwise, including but not 
limited to, content, quality, accuracy, completeness, effectiveness, reliability, fitness for 
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a particular purpose, usefulness, use or results to be obtained from this Data, or that the 
Data or server will be uninterrupted or error-free. 
 
13. Termination:  This Agreement will terminate immediately upon any of the following 
events: 
 

a) If you seek an order for relief under the bankruptcy laws of the United States or 
similar laws of any other jurisdiction, or a composition with or assignment for the 
benefit of creditors, or dissolution or liquidation, or if proceedings under any 
bankruptcy or insolvency law are commenced against you and are not discharged 
within thirty (30) calendar days. 
 
b) If you materially breach any terms, conditions, use limitations, payment 
obligations, or any other terms of this Agreement. 
 
c) Upon expiration of any written supplemental license agreement between you and 
ALK of which this license is a part. 

 
14. Obligations on Termination: Termination or expiration of this Agreement shall not 
be construed to release you from any obligations that existed prior to the date of such 
termination or expiration. 
 
15. Hold Harmless and Indemnity:  To the maximum extent permitted by applicable law, 
you agree to hold harmless and indemnify ALK and its parent company, subsidiaries, 
affiliates, officers, agents, licensors, owners, co-branders, other partners, and employees 
from and against any third party claim (other than a third party claim for Intellectual 
Property Rights) arising from or in any way related to your use of PC*MILER|Rail, 
including any liability or expense arising from all claims, losses, damages (actual and/or 
consequential), suits, judgments, litigation costs and attorneys' fees, of every kind and 
nature. ALK shall use good faith efforts to provide you with written notice of such 
claim, suit or action. 
 
16. Intentionally omitted. 
 
17. Limitations on Export: You hereby expressly agree not to export PC*MILER|Rail, in 
whole or in part, or any data derived therefrom, in violation of any export or other laws 
or regulations of the United States. 
 
18. Aggregated Data: ALK may, from time to time, share information about You with 
parent and sister or affiliated companies for business purposes and when necessary for it 
to perform work under this Agreement.  In addition, ALK may, and is hereby authorized 
to, use, share and provide certain aggregated, non-identifiable information derived from 
Your use of PC*MILER|Rail to third parties. 
 
19. Intentionally omitted 
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20. Additional Use Terms, Conditions, Restrictions and Obligations:  This agreement 
and your use of PC*MILER|Rail is expressly subject to the ALK Privacy Policy and the 
ALK End User License Agreement Terms and Conditions (“EULA”) set forth below. 
YOU ACKNOWLEDGE AND AGREE THAT YOU MAY NOT USE PC*MILER|Rail 
IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF THE ALK EULA 
AND THAT YOU HAVE REVIEWED AND ACCEPT THE TERMS AND 
CONDITIONS OF THE ALK EULA BY INSTALLING OR ACTUALLY USING 
PC*MILER|Rail. 
 
21. Miscellaneous: This agreement shall be construed and applied in accordance with 
the laws of the State of New Jersey.  The Courts of the State of New Jersey shall be the 
exclusive forum for all actions or interpretation pertaining to this agreement.  Any 
amendments or addenda to this agreement shall be in writing executed by all parties 
hereto.  This is the entire agreement between the parties and supersedes any prior or 
contemporaneous agreements or understandings.  Should any provision of this 
agreement be found to be illegal or unenforceable, then only so much of this agreement 
as shall be illegal or unenforceable shall be stricken and the balance of this agreement 
shall remain in full force and effect. 
 
22. Date: This EULA was last updated on November 2, 2015. Visit www.pcmiler.com 
for regular updates. 
 
END USER LICENSE AGREEMENT FOR ALK DATA  
 
This license applies to ALK Data included in PC*MILER|Rail if any, as well as to ALK 
data you obtain separately that is formatted for use with your Software. 
 
The data (“Data”) is provided for your personal, internal use only and not for resale.  It 
is protected by copyright, and is subject to the following terms and conditions which are 
agreed to by you, on the one hand, and ALK Technologies, Inc. (“ALK”) and its 
licensors (including their licensors and suppliers) on the other hand. 
 
© 2015 ALK.  All rights reserved. 
 
1. Personal Use Only:  “You” means you as an End-user or as a “Company” on behalf of 
its End-Users which are subject to either a Non-Disclosure Agreement as employees or a 
License Agreement that contains the same restrictions as herein as a Value Added 
Reseller.  Also as used in this EULA “personal use” can also be understood in more 
general terms as for a Company’s use. You agree to use this Data together with 
PC*MILER|Rail for the solely personal, non-commercial purposes for which you were 
licensed, and not for service bureau, time-sharing or other similar purposes.  
Accordingly, but subject to the restrictions set forth in the following paragraphs, you 
may copy this Data only as necessary for your personal use to (i) view it, and (ii) save it, 
provided that you do not remove any copyright notices that appear and do not modify 
the Data in any way.  You agree not to otherwise reproduce copy, modify, decompile, 
disassemble or reverse engineer any portion of this Data, and may not transfer or 
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distribute it in any form, for any purpose, except to the extent permitted by mandatory 
laws. 
 
2. Restrictions: Except where you have been specifically licensed to do so by ALK in 
the case of an integrated solution bundled or intended for use with specific smartphones, 
similar mobile communication device(s) or personal navigation device(s), and without 
limiting the preceding paragraph, you may not use this Data (a) with any products, 
systems, or applications installed or otherwise connected to or in communication with 
vehicles, capable of vehicle navigation, positioning, dispatch, real time route guidance, 
fleet management or similar applications; or (b) with or in communication with any 
positioning devices or any mobile or wireless-connected electronic or computer devices, 
including without limitation cellular phones, smartphones, palmtop and handheld 
computers, pagers, and personal digital assistants or PDAs. You may not use this 
License, any of the Licensed Product, or its reports, to create a competitive product, 
solution or visualization platform. 
 
3. Warning: The Data may contain inaccurate, untimely or incomplete information due 
to the passage of time, changing circumstances, sources used and the nature of collecting 
comprehensive geographic data, any of which may lead to incorrect results.  The 
Highway Data is based on official highway maps, the Code of Federal Regulations, and 
information provided by state governments and other licensors.  It is provided without a 
warranty of any kind. The user assumes full responsibility for any delay, expense, loss 
or damage that may occur as a result of use of the Data. 
 
4. No Warranty: This Data is provided to you “as is,” and you agree to use it at your 
own risk.  ALK and its licensors (and their licensors and suppliers) make no guarantees, 
representations or warranties of any kind, express or implied, arising by law or 
otherwise, including but not limited to, content, quality, accuracy, completeness, 
effectiveness, reliability, fitness for a particular purpose, usefulness, use or results to be 
obtained from this Data, or that the Data or server will be uninterrupted or error-free. 
 
5. Disclaimer of Warranty: ALK AND ITS LICENSORS (INCLUDING THEIR 
LICENSORS AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS 
OR IMPLIED, OF QUALITY, PERFORMANCE, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT.  Some 
States, Territories and Countries do not allow certain warranty exclusions, so to that 
extent the above exclusion may not apply to you. 
 
6. Disclaimer of Liability: ALK AND ITS LICENSORS (INCLUDING THEIR 
LICENSORS AND SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN 
RESPECT OF ANY CLAIM, DEMAND OR ACTION, IRRESPECTIVE OF THE 
NATURE OF THE CAUSE OF THE CLAIM, DEMAND OR ACTION 
ALLEGING ANY LOSS, INJURY OR DAMAGES, DIRECT OR INDIRECT, 
WHICH MAY RESULT FROM THE USE OR POSSESSION OF THE 
INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS 
OR SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE 
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OF OR INABILITY TO USE THIS INFORMATION, ANY DEFECT IN THE 
INFORMATION, OR THE BREACH OF THESE TERMS OR CONDITIONS, 
WHETHER IN AN ACTION IN CONTRACT OR TORT OR BASED ON A 
WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and Countries 
do not allow certain liability exclusions or damages limitations, so to that extent the 
above may not apply to you. 
 
7. Export Control:  You agree not to export from anywhere any part of the Data 
provided to you or any direct product thereof except in compliance with and with all 
licenses and approvals required under, applicable export laws, rules and regulations. 
 
8. Entire Agreement:  These terms and conditions constitute the entire agreement 
between ALK (and its licensors, including their licensors and suppliers) and you 
pertaining to the subject matter hereof, and supersedes in their entirety any and all 
written or oral agreements previously existing between us with respect to such subject 
matter. 
 
9. Governing Law:  The above terms and conditions shall be governed by the laws of the 
State of New Jersey.  The courts of the State of New Jersey shall have exclusive 
jurisdiction to settle any and all disputes, claims and actions arising from or in 
connection with the Data provided to you hereunder.  You agree to submit to such 
jurisdiction. 
 
========================================= 
ALK TECHNOLOGIES, INC. | www.alk.com 
========================================= 
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Introduction 

PC*MILER®|Rail-BatchPro™ is a batch processing module created for use with 
ALK’s PC*MILER|Rail.  It can be launched from within another application, 
giving PC*MILER|Rail the power and flexibility to handle the processing of large 
volumes of origin-destination records.  Using an input file of car location 
messages (CLMs) or similarly formatted data, BatchPro enables PC*MILER|Rail 
to calculate the distance between locations identified on a single record (single 
line) or adjacent records.  As part of this process, BatchPro can also generate 
report files that summarize mileage activity by car ID, state/province and railroad 
carrier. 
 
NOTE: It is possible to create an extensive mileage database with BatchPro.  
Under the provisions of your license agreement, any such database must remain 
on the same computer platform on which PC*MILER|Rail is installed.  The 
transfer or porting of data to another computer platform or to a third party is 
strictly prohibited without the written consent of ALK Technologies, Inc. 
 
 

1.1  What is PC*MILER|Rail? 

PC*MILER|Rail is point-to-point rail routing and mileage software.  Its powerful 
North American rail network contains over 240,000 total miles of rail line, over 
49,400 active freight stations, 802 rail carriers, and over 4,000 unique 
junction interchanges.   PC*MILER|Rail provides rail routes and mileage for 
rate determination and negotiation, equipment management, rail car mileage 
auditing, and carrier selection. 
 
Through ALK’s close working relationship with all major railroads, 
PC*MILER|Rail features the industry-leading electronic representation of current 
North American railroad routes and mileage.  For over 30 years, ALK’s railroad 
database has proven to be an accurate source for determining the routes and 
mileage used in processing the U.S. Surface Transportation Board’s Carload 
Waybill Sample.  It has also been used in numerous traffic diversion studies and 
in a variety of costing applications.  ALK’s railroad database is widely used by 
virtually all major railroads and rail car lessors.  
 
PC*MILER|Rail generates routes and determines mileage between any two rail-
served locations in North America.  Each location can be identified by station 
name and state abbreviation or by commonly used geographic codes.   
 
With PC*MILER|Rail you can quickly calculate the Shortest route (least 
distance) and/or the Practical route (based on historical operations) between any 
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two points.  You may specify interline junctions or let PC*MILER|Rail choose 
junctions by weighing location versus gateway importance.  A Fuel Surcharge 
routing option is provided to accommodate the Surface Transportation Board 
ruling on mileage-based fuel surcharge calculations. Routings for Intermodal, 
Coal/Bulk and multi-level Auto Rack trains are also included. 
 
 

1.2  PC*MILER|Rail Route Calculation 

PC*MILER|Rail uses a minimum impedance routing program for computing 
routes.  The link impedance used in route calculations is derived as distance 
multiplied by a cost factor, which essentially corresponds to route quality.  High 
density mainlines are given a lower link cost, while medium density mainline, 
medium density branchline, and low density branchline have higher cost factors.  
The minimum impedance route between any two nodes (geographic locations) on 
ALK’s Rail Network is the sequence of links whose impedance sum is less than 
that of any other sequence of links.  
 
For interline routes calculated from the AutoRouter, junction interchange 
impedances are added to link impedances. The junction impedance for the 
forwarding and receiving railroads is based on the historic volume of traffic 
interchanged at that junction to/from those railroads. 
 
Link costs and junction costs may be different for each of the PC*MILER|Rail 
routing types. Additionally, the link costs are adjusted to accommodate any 
directional routing arrangements. 
 
All the various cost factors have been derived from extensive research using 
railroad timetables, maps provided by railroads, the Official Railway Guide, 
Official Railroad Station List, railroad atlases, city and county maps, and articles 
from railroad industry resources.  ALK has periodically updated these costs over 
the years to maintain a good match with current realistic routes. 
 
See section 3.6, Output Options, for a description of route formulas and other 
route options that affect how rail lines and junctions are selected for a route, total 
route mileage, and (with AutoRouting) the number of routes that are generated. 
 
 

1.3  New in BatchPro Version 22 

• NEW!... User Interface Redesigned.  Keeping pace with recent trends in 
technology, PC*MILER|Rail-BatchPro has been updated with a new user 
interface while retaining the same features and functionality that users are 
familiar with from previous versions. 

• NEW!... Format File Creation Simplified.  Previous versions of BatchPro 
required users to create a .DIR format file manually or by editing a supplied 
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template.  The .DIR file described the layout of the columns in an input file 
using start and end positions, allowing BatchPro to identify where each data 
element (SPLC, car number, etc.) was located in a record.  In Version 22 the 
input file format is entered directly into the BatchPro window and can be 
saved for future use in a .CFG configuration file, eliminating the need to 
create a separate format file.  

 
• NEW!... Route Options Can Now Be Saved.  An advantage of the new .CFG 

format files described above is that route options selected in the BatchPro 
window can be saved to the current .CFG file along with format information.  
For users this means that when the .CFG file is used again, the previously 
selected route options will be applied automatically unless they are changed in 
the BatchPro window.  

• ENHANCEMENT!… Error Message Update.  The error messages that 
BatchPro returns have been updated to provide improved guidance.  
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Installing PC*MILER|Rail-BatchPro 

PC*MILER|Rail-BatchPro is an add-on product that can be installed when you 
install PC*MILER|Rail or at a later time.  See section 2.2 below if you already 
have a base installation of PC*MILER|Rail 22 and are adding BatchPro. 
 
To install a full PC*MILER|Rail 22 installation with the BatchPro add-on, see 
your PC*MILER|Rail User’s Guide or Getting Started Guide for complete 
instructions. 
 
 

2.1  Requirements 

The PC*MILER|Rail-Connect product is intended to allow language-independent 
Windows application development. You need to have: 

• An installation of PC*MILER|Rail Version 22. 

• PC/LAN Windows (Windows 7, 8 or 10). 

• PC with a 1.5-2 GHz processor or networked personal computers. 

• An additional 1 MB free on your hard disk (in addition to 700 MB required 
for the PC*MILER|Rail database). 

• 512 MB RAM required, 1 GB recommended for standard desktop. 

 
2.2  Adding BatchPro to a PC*MILER|Rail Installation 

If you are purchasing and installing the BatchPro module after PC*MILER|Rail 
has already been installed, follow the steps below:  

First, call PC*MILER Sales at 800.377.6453 (or 1.609.683.0220 outside of the 
U.S.), 9:00am-5:00 pm EST, Monday-Friday to purchase the product and obtain a 
new Product Key Code to license and install the new solution(s). 
 
Once you receive the new product key code, follow the instructions below for a 
single user or multi-user workstation. 
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SINGLE USER AND MULTI-USER SERVER INSTALLATION 

1. Go to the Windows Start menu > Programs (or All Programs) > 
PCMILER Rail 22  > License Status. 

2. In the PC*MILER License Tool window, click Add License. 

3. In the PC*MILER Product Activation window, enter the product key for the 
purchased component and click Add License. 

4. When prompted, enter your Email Address.   

5. Click Activate.  

6. When the activation process is complete, you will see the message “License 
Activation Complete!”.  Close the Product Activation window. 

7. Back in the License Tool window, make sure all new and existing components 
are listed under Licensed Components, then close the window.  

8. To install newly added components, go to the Windows Start menu > 
Control Panel > Programs and Features (or the equivalent on your system). 

9. In the list of installed programs, right click “PC*MILER|Rail 22” and choose 
Change. 

10. In the InstallShield Wizard, choose Modify and click Next. 

11. In the next screen, you will see the list of Licensed Features. All activated 
features will be listed.  Check that the component you are installing is 
included in the list, then click Next to continue. 

12. In the next screen you’ll see the Destination Folder for the installation.  Click 
Next to start copying files. 

13. When the installation is complete, click Finish. 
 

 
MULTI-USER INSTALLATION, FROM A WORKSTATION 

1. Go to the workstation. 

2. Browse to the shared …\PCRWIN22\network folder on the server. 

3. Run the setup.exe and choose Modify. 

4. Follow through with the rest of the installation (steps 10-13 above). 
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2.3  Technical Support Options 

ALK Technologies offers free technical support to all users of PC*MILER|Rail 
and related products.  If you have any questions or problems with the software 
that cannot be resolved using this User’s Guide, contact ALK Technologies. 

 
Hours: 8:00am - 5:00pm, Mon-Fri, Eastern Standard Time 
Phone: 1.800.377.6453 ext. 2, or 1.609.683.0220  ext. 2 
Email: pcmsupport@alk.com or from within PC*MILER|Rail 

select the Help tab > Email Technical Support and 
follow the instructions provided.  If you have any 
supporting material, click Attach File and browse for 
the file(s) to attach. Attachments of supporting 
documentation can be up to 10 MB.  When ready, click 
Send.  ALK's technical support team will send a 
confirmation email to the email entered in the "Enter 
your email here" field when it is received. 
 
Please include your Product Key Code and product 
version number (e.g. 22.0.1) in all correspondence.  To 
find this information, go to the Help tab > About. 

Fax: 1.609.252.8108 
ATTN: PC*MILER|Rail Technical Support 

Web Site: www.pcmiler.com (click Support > PC*MILER|Rail) 
 
 

2.4  User Guides 

NOTE: You must have Adobe Acrobat Reader on your computer to properly 
view the PDF user guides for PC*MILER|Rail products.  (Using another PDF 
reader may cause faulty pagination or other problems.)  If you do not have this 
program installed already, a free copy can be downloaded from www.adobe.com.   

 
To make Adobe Reader your default reader, from within the Adobe Reader 
application select the Edit menu > Preferences > General and click Select Default 
PDF Handler.  Select Adobe Reader from the drop-down, and click Apply then 
OK to close the Preferences dialog. 

 
To access the user guide for any PC*MILER|Rail product, click the Windows 
Start button > All Programs (or the equivalent on your system) > PCMILER 
Rail 22  > User Guides and select one of the .pdf files. 

 
 PC*MILER|Rail-BatchPro User’s Guide 6 

mailto:pcmsupport@alk.com
http://www.pcmiler.com/


   

 

Using PC*MILER|Rail-BatchPro 

 
 

 
 

PC*MILER|Rail-BatchPro Window 
 
 

3.1  How Does BatchPro Work? 

BatchPro works as follows: the name of your input file of car records is passed as 
a parameter to BatchPro.  Guided by the description of the input file format that is 
entered in the BatchPro window, PC*MILER|Rail first determines the validity of 
the sighting railroad/sighting location combinations contained in the file.  
PC*MILER|Rail then attempts to generate a mileage for each valid pair of 
consecutive records or each single record containing a valid O/D pair.     
 
An output file is created in which the mileage figure is placed at the end of each 
record from the input file.  The output file is named xxxxxxxx.OUT, where 
“xxxxxxxx” is the name of the input file, and is placed in a folder that you specify 
or in the folder where the input file resides.  If mileage is not generated for an 
O/D pair due to processing errors, data errors, or other factors, an error message 
will be generated in the .OUT file. 
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3.2  How to Use BatchPro  

The steps to generate BatchPro mileage and reports are below. See sections 3.3 – 
3.14 for more detailed instructions.  
 
1. To open the BatchPro window, go to the Windows Start menu > All Programs 

(or the equivalent on your system) > PCMILER Rail 22 > BatchPro and click 
PCMILER Rail-BatchPro 22. 

2. At the top of the BatchPro window, designate an Input File of car records 
using the Browse button.  

3. To the right, select a Configuration File that matches the type of input in 
your input file. 

4. If necessary, under Options edit the column positions in the configuration file 
to match the current input file (Input File Layout tab). 

5. If necessary, select how stations are formatted in the origin and destination 
columns of the input file (Origin Location Type and Destination Location 
Type drop-downs). 

6. In the Line Format drop-down, select O/D Pair Per Line if the input file 
includes one origin/destination pair per line (this is required for AutoRouting), 
or Single Location Per Line if each line includes only one station. 

7. (Optional)  Under Options, in the Output Options tab adjust routing and 
output options as needed. 

8. (Optional)  Under Output Report Files, designate a location where output 
files will be placed.  By default, output files are placed in the folder where the 
input file is located. 

9. (Optional, for Standard routing only)  Under Optional, select report files to 
generate in addition to the default mileage output (.OUT file).    

10. Click Run to begin batch processing.  Depending on the options you chose, a 
minimum of two output files will be created (.LOG and .OUT files) in the 
folder where the input file resides or in another user-designated location. 

 
 

3.3  Input File Requirements 

To generate distances, PC*MILER|Rail-BatchPro requires an input file (.IN) of 
car records and a configuration file (.CFG) which enables BatchPro to interpret 
the data in the input file correctly. 
 
Under Input File in the BatchPro window, use the Browse button to select your 
input file. 
 
Car sighting data may be gathered for input via electronic data interchange (EDI) 
directly from major rail carriers using a communications software package, 
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through third parties such as RAILINC or Kleinschmidt, Inc., or even edited via 
software such as Lotus or dBase.  
  
Input data must be in flat ASCII files.  Each record in the input file must contain 
at least one geographic location, and may contain fields identifying empty/loaded 
status and car mark/number.  Additionally, a car number or car ID is required for 
files that have one station per line, to distinguish where each trip starts and ends.  
In the sample file below, you can see two complete trips – for car GATX 123456 
and GATX 234567.  
 
 

 
Sample Input File – One Location Per Line 

 
 
Standard routes need a railroad column, while AutoRoutes can be run without a 
railroad, with a pair of railroads, or with just one railroad (at either the origin or 
destination).  If no railroad is specified for AutoRoutes, multiple routes will be 
generated.  
  
NOTE:  Comment lines starting with a semi-colon (;) are permitted in input files. 
NOTE Also:  Since batch processing may create several large output files, your 
available hard disk space must be approximately twice as large as the size of the 
input file. 

 
Sample input files with the file extension “.in” are included with the BatchPro 
installation.  The default installation location is C:\ALK Technologies\ 
PCRWIN22\BatchPro. 
 
 

 3.4  Configuration Files 

After selecting an input file, you must select a .CFG configuration file. This file 
describes the layout of the columns in your input file using start and end 
positions, allowing BatchPro to identify where each data element (SPLC, car 
number, etc.) is located in each record in your input file. The .CFG file also 
specifies output and route options. 
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In the BatchPro window, use the Configuration File drop-down to select a 
configuration file.  Five .CFG templates are initially provided. After selecting a 
.CFG, you’ll see that file’s default options displayed under Options. You can 
then customize the options and save the file for future use – click Save As to give 
the file a new name, or Save to retain the same filename and overwrite the 
original template.  By default your edited files are saved in the App folder of the 
PC*MILER|Rail installation (usually C:\ALK Technologies\PCRWIN22\App), 
they must be saved in this folder to be seen in the Configuration File drop-
down.   
 
NOTE:  Please note that only advanced users should manually edit a 
configuration file. Also note that if a configuration file is added to the App folder 
while BatchPro is already running, it won’t be available in the Configuration File 
drop-down.        
 

 

 
Default Layout for the BP_SPLC_AR_Railroads .CFG Template File 

 
 

3.5  Input File Layout Options 

The Input File Layout options enable BatchPro to locate and identify the data in 
each record of your input file.  The ASCII text file below shows character 
positions at the top to illustrate the concept of column start/end positions in the 
input file layout: 
 
 

 
 
 

 
 

 
 
 

Destination column starts at 
Position 27 

Origin column starts at 
Position 6 
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The Input File Layout values can be edited as follows: 
 
Origin/Destination Location Type:  In the drop-down, select the type of 
location in the origin and destination columns. The type must be the same within 
a column, but the columns can have different types; for example, origins can be 
SPLC and destinations can be Station Name/ST. 
 
Line Format:  The option selected here must match your input file, otherwise the 
file won’t be processed.  Select whether records in the input file include an origin 
and destination on one line (O/D Pair Per Line) or a Single Location Per Line.  
In the latter case, mileage is generated between locations in each consecutive line.  
 
NOTE:  OD Pair Per Line is required for AutoRouting, AutoRoutes won’t run 
using the Single Location Per Line format.  
 
Origin/Destination:  Enter the start and end positions of the origin and 
destination locations in each record.  For a one-per-line file, the destination is 
ignored. 
 
Origin/Destination Railroad:  If the file includes railroads, enter the start and 
end positions of the origin and destination railroads in each record.  For a one-
per-line file, the destination railroad value is ignored. 
 
Car ID:  If the file includes car IDs, enter the start/end positions of the column.  
For one-station-per-line input, a car ID or car number column must be identified. 
 
Car Number:  If the file includes car numbers, enter the start/end positions of the 
column.  For one-station-per-line input, a car ID or car number column must be 
identified. 
 
Empty/Loaded: If the file includes empty/loaded status, enter the one-byte 
position of the column. 
 
 

3.6  Output Options 

To edit the output and route options in a configuration file, click the Output 
Options tab under Options. 
 

 
Output Options Tab 
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3.6.1  Data Options – Output Type 

 

 
 
Select Standard if you simply want to generate mileage for the origin/destination 
pairs in your input file.  Using this option, if a record is determined to be invalid, 
the mileage for that record is returned as “0”.  “0” mileage will appear if an 
invalid sighting railroad/location is detected, or if a route cannot be run between 
an origin and destination pair as it occurs in the file.   
 
In Standard output, diagnostic checks will identify inconsistencies in the input 
data.  An error message placed to the right or under the mileage field will identify 
the problem.  See section 3.14, Error Messages You May Encounter. 
 
 

 
Error Message in a Standard Output (.OUT) File 

 
 
If All Auto Routes is selected, AutoRouting will be used to calculate mileage for 
every feasible route between each valid origin/destination pair in the input file. 
 
 

 
 

Sample AR Output (.OUT) File Using “All Auto Routes” (column widths adjusted) 
 
 
The AutoRoutes output file shows the number of participating carriers, total 
mileage and the route (railroad – junction sequence) information. At the top of the 

Geocode error for 
an invalid location 
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sample output file shown above, there are four output routes from SPLC 191600 
(Newark NJ) to 883000 (Los Angeles CA), two originating on CSXT and two 
originating on NS.  Route 1 has a total distance of 3181.6 miles and uses the 
junction 396640 (East St. Louis, IL). The distance from 191600 to 396640 is 
1141.8 miles, and the distance from 396640 to 883000 is 2039.8 miles.  
 
In the AutoRoutes output file, an invalid location or other error in a record in the 
input file produces a “No autoroutes were found” error message for that record 
without any additional description: 
 

 
   
NOTE:  The output file of AutoRoutes shown above was opened using Notepad 
and column widths were adjusted.  The column layout will vary depending on the 
application you use.  Output files can be opened in Microsoft Excel – select “All 
Files” as the file type. 

 

 
3.6.2  Data Options – Standard Output Options 

 

 
 
These options are available if Standard is the output type.  Select AutoRoute on 
Error to have PC*MILER|Rail interpolate missing junctions (and railroads) from 
incomplete input using AutoRouting where necessary to determine a mileage.  
This is useful if there are records that “skip” from a location on one railroad to a 
different location on another railroad.  (Normally, these sequences generate an 
error message and ignore any potential mileage because there’s no way of 
knowing which railroad(s) carried the car between the locations.)  
  
The inferred segments appear in the output file and are used to determine the 
mileage by railroad and state in reports.  This option reduces output errors by 
using ALK’s routing assumptions to connect otherwise unconnected records. 
 
If Round Miles is checked, all mileages will be rounded to the nearest whole 
number.  If it is not checked, tenths of miles are shown. 
 
NOTE:  You should review the output file and check the frequency and/or 
seriousness of any diagnostic messages that appear.  Depending on how “clean” 
the data is, you may want to review and edit the original input and then rerun 
batch processing.  See section 3.13, Correcting Recurring Data Errors. 
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3.6.3  Route Options – Route Preference 

 

 
 
The default value for Route Preference is always Practical. 
   
- Practical routings simulate the most likely movements of general 

merchandise train traffic. Main lines are preferred to branch lines. A Practical 
route can sometimes be more circuitous than the shortest possible route.   

- Shortest route calculations find the rail route with the least distance between 
the stops. For a Standard route, the shortest path within the railroad is 
determined for each segment.  For AutoRoutes, the shortest path across all 
North American railroads is calculated, irrespective of origin and destination 
railroad specifications. 

- Intermodal, Coal/Bulk, or Auto Racks can be used to determine the 
exceptional routings that these types of trains sometimes require. 

- Fuel Surcharge routing is essentially a combination of the Shortest and 
Practical route formulas (because some railroads use Shortest mileage and 
some use Practical mileage when figuring their fuel surcharges). It provides 
mileage suitable for calculating fuel surcharges in conformance with the 
Surface Transportation Board ruling STB Ex Parte No. 661.   
 
NOTE:  Fuel Surcharge routing is not available for AutoRoutes. 

 

 
3.6.4  Route Options – AutoRouter Terminal Switching 

 

 
 
When using AutoRouting, routes with the originating or terminating carrier having 
a switch move only (common with terminal railroads) may be included or excluded 
from the list of generated routes, depending on whether Include or Exclude is 
chosen.   
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The Terminal Switching option affects the number of routes that are generated.  For 
example, between Los Angeles, CA and Charleston, SC there are nine AutoRoutes 
generated when switch-move-only carriers are included, and only four generated 
when these carriers are excluded. 
 
 

3.7  Sample Input:  One SPLC Per Line – Standard Routing 

The records in the sample file BP_SPLC_OnePerLine_Std.in include one SPLC 
per line as shown below.  From left to right in this file, each record includes a 
SPLC, a railroad, the empty/loaded status of the car, the initials contained in the 
car ID, and the car ID number.  In this type of one-per-line input, there must be a 
car number or ID for each record to distinguish where a trip starts and ends.  In 
this sample file, three trips are listed (for car number 123456, 234567, and 
999999). 

 

 

“BP_SPLC_OnePerLine_Std.in” Sample Input File 
 

 
 
 
 
 
 
 
 
 
 
 

Default Layout Options in the “BP_SPLC_OnePerLine_Std.in” Sample Configuration File 
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3.8  Sample Input:  One O/D Pair Per Line – Standard Routing 

Each record in the sample file BP_StationNameState_Pair_Std.in includes an 
origin and a destination in station/state format.  From left to right in this file, each 
record includes a railroad, an origin and a destination in station/state format, and 
the empty/loaded status of the trip.   

 
 

 
 
 
 

 
 
 
 

 
 

“BP_StationNameState_Pair_Std” Sample Input File and .CFG Layout Options 
 

 

3.9  Sample Input:  One O/D Pair Per Line – AutoRouting 

Each record in the sample file BP_StationNameState_Pair_AR.in includes only 
an origin and a destination in station/state format.  Because there is no railroad 
information, all possible routes will be generated. 

 

 
 
 
 

 
 
 
 

 
 

“BP_StationNameState_Pair_AR” Sample Input File and .CFG Layout Options 
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3.10  Sample Input:  O/D Pair With Railroads – AutoRouting 

Each record in the sample file BP_SPLC_AR_Railroads.in includes an origin 
railroad and SPLC, and a destination railroad and SPLC.   

 

 
 
 
 

 
 
 
 

 
 

“BP_SPLC_AR_Railroads” Sample Input File and .CFG Layout Options 
 

 
3.11  Options for Output Report Files 

 

 
 

 
For every input file that BatchPro processes, an output file of mileage with the 
extension “.OUT” will be generated. Under Default, click Browse to select a 
location where the mileage output file will be placed.  If a custom location is not 
specified, by default the .OUT file will always be placed in the same folder as the 
input file.   
 
Additionally, a log file will always be generated – see section 3.12 below. 
 
For Standard routes, up to seven report files can also be selected under Optional 
– see Chapter 4, Optional Report Files, for descriptions of these reports. 
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Sample .OUT File (One Per Line Input) 

 
 
3.12  Automatic Log File 

BatchPro automatically generates a log file for each batch file that is run, placing 
it in the same folder as other output files.  The .LOG file is a complete record for 
reference that includes date/time, input and output file names/locations, options 
used, and processing information as shown in the sample file below.   

 

 
Sample .LOG File 
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3.13  Correcting Recurring Data Errors with Override Files 

If you are experiencing recurring errors during route entry because the station or 
railroad you attempted to enter can’t be found in the PC*MILER|Rail database, 
there are override files you can use to correct this problem.  These text files are 
located in the RailNet subdirectory of your PC*MILER|Rail installation, usually 
C:\ALK Technologies\PCRWIN22\Data\Rail\Base\RailNet. 
 
The data override files can be used whenever different codes or names for stations 
in the user’s database do not exactly match those registered with the Centralized 
Station Master files, the source for the PC*MILER|Rail database.   
 
Additionally, the override feature allows users to run routes to new stations 
created after the latest release of PC*MILER|Rail, by using a neighboring station 
as a proxy to generate non-error routes with almost correct mileage. 
 
Override files can also be used to create custom location names (use the 
OVERRIDE.NAM file) and to edit or create junction interchange preferences for 
interline routing (use the OVERRIDE.JCT file).   
 
Each override file now includes instructions for its use, in comment lines 
beginning with the pound sign (#) at the top of the file.  Additionally, an 
“Example Override Data.txt” file containing examples is included in the same 
folder as the override files. 
 
There are six override files for six types of station and railroad input: 
 
OVERRIDE.ERP 
OVERRIDE.FSC 
OVERRIDE.NAM 
OVERRIDE.SCA 
OVERRIDE.SPL 
OVERRIDE.JCT   
 
These files are blank initially (except for instructions), and may be filled with 
records (rows of text) in the correct format for each type.  The records you add 
will tell PC*MILER|Rail that “when this is entered, it means that”.  
 
The added records must include an input column and a translation column.  The 
input column contains an abbreviation or numerical configuration that a user 
might enter as a station location or railroad during route entry, and the translation 
column contains the valid entry for that location that PC*MILER|Rail will 
recognize because it matches what’s in the database. 
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Follow the steps below to add records to an override file:  
 

1. Find the RailNet folder in your PC*MILER|Rail installation.  For a typical 
installation, go to: 

C:\ALK Technologies\PCRWIN22\Data\Rail\Base\RailNet;  

or if the installation location was customized, search for the RailNet folder 
using Windows Explorer. 

2. Right-click on one of the override files and open it using Notepad or 
Wordpad. 

3. In the override file, type your entries, matching the column structure 
appropriate to the file type (see descriptions for each file type below). 

4. To save your changes, select File > Save at the top of the Notepad or Wordpad 
window.  The stations, railroads and/or preferences you added will now be 
valid when you input them during route entry.   

 
Sample records for each file type are shown below.  Detailed instructions for 
adding entries are included at the top of each file, in lines preceded by the pound 
sign (#).  
 
OVERRIDE.SCA 
 
TFM KCSM; 
 
The format for the entry must be: old or custom RR (SCAC) in positions 1-4, a 
blank, the proxy SCAC (recognized by PC*MILER|Rail 22), and a semicolon at 
the end. 
 

OVERRIDE.FSC 
 
ABCD 10000 09999;   
 
The format for the entry must be: RR SCAC in positions 1-4, a blank, the new or 
custom 5-digit FSAC, a blank, the 5-digit proxy FSAC (recognized by 
PC*MILER|Rail 22), and a semicolon at the end. 
 
OVERRIDE.SPL 
 
ABCD 110000 089999;   
 
The format for the entry must be: RR SCAC in positions 1-4, a blank, the new or 
custom 6-digit SPLC, a blank, the 6-digit proxy SPLC (recognized by 
PC*MILER|Rail 22), and a semicolon at the end. 
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OVERRIDE.ERP 
 
PALMCV      PALMER   MA;  
HAGECSXT MD HAGERSTOWMD; 
SALT LAKEUT SALLAKCITUT; 
 
The format for the entry must be: 11-char ERPC/3-3-3 (new or custom code), a 
blank, the 11-char (including a 2-character state abbreviation in the last two 
places) proxy ERPC/3-3-3 (recognized by PC*MILER|Rail 22), and a semicolon 
at the end. 
 

OVERRIDE.NAM 
 
MOOJAW SK MOOSE JAW SK; 
YOYO IL   CHICAGO IL; 
 
The format for the entry must be: up to 22-char name (new or custom station 
name), a blank, the up to 22-char (including a 2-character state abbreviation in the 
last two places) proxy Station Name (recognized by PC*MILER|Rail 22), and a 
semicolon at the end.   
 
OVERRIDE.JCT 
 
BNSF CSXT BHAM  P A; 
BNSF CSXT BHAM  C A; 
BNSF NS   CHGO  I F; 
BNSF NS   CHGO  A F; 
 
The columns in this file from left to right are: 

- RR1, up to 4 characters followed by 1 blank  
- RR2, up to 4 characters followed by 1 blank  
- R260 junction code, up to 5 characters followed by 1 blank 
- Route type to which the preference will be applied (P=Practical, C=Coal/Bulk, 

I=Intermodal, A=Auto Racks), 1 character followed by 1 blank 
- Type of preference (A=Avoid, F=Favor), 1 character followed by a semicolon 
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3.14  Error Messages You May Encounter 

Error messages you may encounter as you use PC*MILER|Rail-BatchPro are listed in the table below with brief 
descriptions.  Error messages appear in the .OUT output file on the line relevant to the error.  If you continue to see the 
same error message and cannot resolve the problem, please contact ALK Technical Support (see section 2.3). 

 
Error Message Action/Explanation of Error Code Average Frequency 

 "Internal memory error." Call Technical Support Extremely Rare. 
 "Invalid argument passed into API function." Call Technical Support Extremely Rare. 

 "Error: Previous RR does not serve this location." Inbound and Outbound Railroads do not 
junction at this location. 

Common; Use "AutoRoute on Error" or 
AutoRouter. 

 "Error: Railroad stations are disconnected" Inbound and Outbound Railroads do not 
junction at this location. 

Common; Use "AutoRoute on Error" or 
AutoRouter. 

 "Error: This trip contains no stops." Either no stops or only 1 stop. Extremely Common; A prior Geocode has 
failed. 

 "Error: Unable to retrieve name information for 
given stop." Origin or destination are invalid Rare; Data Issue. 

 "No cleanups found for one or more stops in this 
trip." 

Origin and destination combination are 
invalid Rare; Geocoding Issue. 

 "Error: This trip contains no legs." Origin and destination combination are 
invalid Uncommon; Routing Error. 

 "Error: Invalid network data." Call Technical Support Extremely Rare; Bad Configuration. 
 "Error: Invalid min path data." Call Technical Support Extremely Rare; Bad Configuration. 

 "Error: This trip contains an invalid leg." Origin and destination combination are 
invalid Uncommon; Routing Error. 

 "Error: Intermodal stations were found but 
excluded." 

Intermodal is set to exclude but the stop is 
using an intermodal 

Common; Ensure Intermodal Options as 
intended. 

 "Error: Station does not have intermodal service." Route is Intermodal but the stop does not 
support it. 

Common; Ensure Intermodal Options as 
intended. 

 "No autoroutes were found." The AutoRouter cannot generate a valid route 
given the Stops and Options. 

Rare; Most AutoRoutes should succeed 
unless totally disconnected. 

 "Routing was cancelled."  The BatchPro run was cancelled. Extremely Rare; Only when Cancelling 
Interactive. 

 "Unknown Error" Call Technical Support Rare. 
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PREFIXES:   
"TripError: " Prefix for a Runtime Trip Error.  
"GeoError:" Prefix for a Geocode Error in a Single Line.  
"GeoErrorO:" Prefix for a Geocode Error in the Origin.  
"GeoErrorD:" Prefix for a Geocode Error in the Destination.  
   
NOTES AND COMMENTS:   

" Trip Failure, using AutoRouter." Displays when using the "AutoRoute on 
Error" option and an Error Occurs.  

" No implcit junctions available. AutoRouting failure." Displays when there is no valid result from 
"AutoRoute on Error" attempt.  

"New Car Number" Comment displaying that there's a new Car 
Number.  

"New Car Mark" Comment displaying that there's a new Car 
Mark (ID).  

"E/L Change" Comment displaying when the Empty/Loaded 
status changes.  
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3.15  Using BatchPro From the Command Line 

The BatchPro application can be run from your PC’s command line, without 
invoking the user interface.  This feature is useful for scheduled runs, running a 
sequence of batch files, or for running BatchPro from another application – for 
example, executing an overnight batch run for your scheduler. 
 
While running BatchPro from the command line does not allow users to modify 
the options, it can take a pre-existing input file and configuration file and process 
the origin/destination pairs without the additional overhead of the UI. Using the 
command line allows for automation and scripting without the need to pop up a 
visual element. 
 
NOTE:  Configuration files can only be modified in the user interface.    
 
The syntax of opening BatchPro from the command line involves invoking the 
ALK.BatchproRail.Desktop.exe with additional parameters. The .exe can be 
found in the App folder of the PC*MILER|Rail installation. There are two 
required parameters and one optional: 
 
-input: – Provide the input file (relative or absolute path), ending in .IN. 
 
-config: – Provide the name of the configuration file saved or created by the user 

(without the “.CFG” extension). 
 
-output: – (This parameter is optional.)  Provide the (Base) name of the output 

file if it will be different from the input file.  Do not include ".OUT" as 
all reports are based off of it. 

 
Upon completion, the application will output the same message as the UI does in 
the bottom right and you may then check the .LOG and .OUT files associated 
with your input for more detail. 

 

 
 
 
 
 
 

 
 PC*MILER|Rail-BatchPro User’s Guide 24 



   

 

Optional Report Files 

In addition to the mileage output file, BatchPro can generate up to seven report 
files each time it processes an input file.  Under Output Report Files, place a 
checkmark next to the optional report(s) you want to generate.  These options are 
available only when “Standard” is selected as the output type. 

 

 
 
 
To see any generated report, in Windows Explorer navigate to the folder where 
the output files were placed.  Right-click the file name and open it with Notepad 
or Wordpad. 
 
Samples of each report type are shown below and on the following pages. 
 
 
 

4.1  Mileage By Railroad Carrier (.CAR) 

The Carrier file (.CAR) summarizes mileage by railroad carrier. 

 

 
 

Sample .CAR Report File 
 

4 C
ha

pt
er
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4.2  Mileage By Car ID and Railroad (.DET) 

The Detailed file (.DET) summarizes mileage by both car mark and railroad: 
 
 

 
 

Sample .DET Report File 
 

 

4.3  Mileage By Car ID (.CID) 

The Car ID file (.CID) summarizes mileage by car mark and number: 
 

 

 
 

Sample .CID Report File 
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4.4  Mileage By State or Province (.STM) 

The State Mileage file (.STM) summarizes empty, loaded and total mileage by 
state or province: 

 
 

 
 

Sample .STM Report File 
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4.5  Mileage By Carrier and State (.RRS) 

The Railroad-State file (.RRS) summarizes empty, loaded, and total mileages by 
carrier and state: 

 
 

 
 

Sample .RRS Report File 
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4.6  Mileage By Car ID and State/Province (.IDS) 

The ID-State file (.IDS) summarizes empty, loaded and total mileages by both car 
ID and state or province: 

 
 

 
 

Sample .IDS Report File 
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4.7  Detailed Report (.RPT) 

The Detailed Report option generates a Detailed Geocode Report for each 
origin/destination pair that is processed.  This file is intended for customers who 
want to review individual routes from the batch run.  
 
IMPORTANT NOTE:  Selecting the Detailed Report output option will slow 
down the batch process. The resulting file can be extremely large, as it will 
contain every station location and all leg and cumulative miles along the route, 
followed by a summary report by railroad and state for every origin-destination 
pair in the input file. Hence it is recommended that this report be generated only 
for small batch runs.  
 
The contents of this report are the same as in the Detailed Geocode Report in the 
PC*MILER|Rail user interface.  The output file is tab delimited and will align 
into appropriate columns when opened with Microsoft Excel (be sure to choose 
“All Files” in the file type drop-down in Excel, otherwise you won’t see the .RPT 
file listed).   
 
For each O/D pair, the .RPT lists all points on the route, along with leg and 
cumulative mileage. Each O/D pair route is demarcated with a dashed line (-----), 
under which the origin, destination and corresponding line number from the .OUT 
file is listed.  A state mileage summary and breakdown of mileage by railroad is 
included at the end of each route’s report. 
  
 

 
Sample .RPT Report File 
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State Mileage Summary at the End of a Route in the Detailed Report 
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